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Overview
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Overview - Printer Maintainer

This document explains the operation of the Printer Maintainer utility and how to configure a
scheduled job on Windows or macOS to run it at regular intervals.

The Printer Maintainer app is designed to be scheduled to run at regular intervals in order to
prevent inkjet printer heads from drying out and getting clogged.

Manual Revision 3
Printer Maintainer 1.32
4/5/2020

[Revision Notes: Added updated screensshots, information about configuring multiple printers,
and troubleshooting printer naming on macOS.]
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Installation
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Windows Installation - Printer Maintainer

Unzip Application
f E] = | Extract C:\ds\Printer Maintainer - O X
Home Share View Compressed Folder Tools o
., Cut = en~ Select all
2 02 ¢ [B] o &
— w.. Copy path o - ind t 1o Select none
Pinto Quick Copy Paste Move Copy B IO -
access t] Paste shortcut to~ to~ tory 5 Invert selection
. I Extract All... i
Clipboard Org Select
7-Zip >
« v 1 > ThisPC » Local Disk(C:) > ds > Pr CRC SHA S v & | SearchPri.. 0
A Name P FolderSizes 8 >
s Quick access _ Pin to Start
I Desktop * ‘con
' Printer Mainta P
; Downloads ’ ¢ PrinterMaintai Show in Finder
[&] Pictures * Share on >
customer files - ¥ Install with Revo Uninstaller Pro No preview available.
[ Documents p £ Scan with Windows Defender...
fmpro_migrator b g 12 Share
#9 iCloud Drive (Mac) » Open with >
@ UltraEdit
Desktop
Restore previous versions
fmpro_migrator
v <
) ) Send to > - —
Jitems 1item selected 7.35 MB =z =]

The Printer Maintainer utility is delivered as a zip file. Right click on the zip file, and select Extract
All... from the contextual menu to unzip the file.

Move Application Folder (Optional)

Name

Printer Maintainer 1.01

¢ PrinterMaintainer1.01Windows.zip

Date moc
2/13/20 1
2/10/209
2/10/209

You can move the application folder to the Program files folder or wherever else you find
convenient. No installation application is required.
The first time the app runs, it will create a preferences folder named Printer Maintainer within the
Documents directory. A preferences file named Printer_Maintainer_Prefs.json will be created

within this folder.
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macOS Installation - Printer Maintainer

Open DMG File

pplications

Orinter Maintaine

g

= [m = o6
Favorites Adobe Creative Cloud > . il printer maniBinar

@ AirDrop 3 Adobe Dreamweaver 2020 > Printer Maintainer.app .

F& Affinity Designer.app
@ Recents R Affinity Photo.app
@ Desktop B} Affinity Publisher Beta.app B

K\ Affinity Publisher.app
lﬂj Documents & affinity-photo-1_Ze@

0 Downloads & affinity_putsfisher-1.7.1.408.dmg PrinterMaintainer1
12} dsimpson hwrrount.app ! ~ -32mac0S.dmg

& App Store.app
A\ Applications % App Wrapper 3.app

[ Apps >
iCloud @ Archiver.app
& iCloud Drive g Automator.app
[ BaseElements_4.6.1 >
Locations 1% BBEdit.app
[ ] David's iPad Pro 12.... O Books.app

Open the PrinterMaintainerX.XXmacOS.dmg file, and drag the app to your Applications folder. The
Printer Maintainer app is a 64-bit app, notarized by Apple to prevent error messages when
launching.

Note: The version number is notincluded in the name of the app, so that it can be updated without
requiring a change to the job scheduler.
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Configuration
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Configuration Options & GUI Explanation

Launching Printer Maintainer - Windows

Name

Externals

,.f Printer Maintainer 1.01.exe

To open the Printer Maintainer app, just open the extracted folder and double-click on the Printer
Maintainer.EXE file.
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Launching Printer Maintainer - macOS

Applications
< 6 = |0 = Bmv | %~ Q
Favorites pg_MPP17 Photo Booth.app Photos Exif Photos.app Pinegrow.app
@ AirDrop Editor.app
@ Recents
&3 Desktop i
@ Documents
PinegrowMac.5.91 Pixelmator.app Podcasts.app Postgres.app PostgreSQL 12
0 Downloads dm
-amg
m dsimpson . Iy
A\ Applications -— ‘ | . ¥ ) —
- s ©) o~ —
iCloud < 'Y
& iCloud Drive postgresql-12.1-1 Preview.app Printer PureBasic- PureBasic.app
-osx.dmg Maintainer.app Demo_x64.dmg
Locations

D David's iPad Pro 12.... i —

Macintosh SSD MBP16 ‘

() MBP16_Backup_1 qb64 qb64_2018-11-01 QuickBooks QuickBooks_QBO QuickBooks.app
Q Printer Maintainer -14-32-...r_osx.tar 2020.app _Mac.dmg

(1) Double-click the Printer Maintainer icon in the Applications folder.
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Stopping the Automatic Countdown

Printer Maintainer

. 4 Printer Maintainer 1.32

www.FmProMigrator.com

This utility runs via a scheduled
job to print a sample page to an
inkjet printer preventing print
heads from drying out.

=4

Print Delay (sec.)

=

Add Printer

10

Default Text:
Cc

-
= C

Print Quit

The Printer Maintainer app will automatically start counting down from 10 seconds when itis
launched.

Clicking anywhere in the window will pause this automatic countdown.
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If you don't click anywhere on the window of the app, Printer Maintainer will attempt to print the
Default Text field contents to all of the printers in the list and then it will quit. If no printers have
been added, the app will just quit after the timer has counted down and no printing will be

attempted.
This screenshot shows that no printers have yet been added to the app for printing.

Printer Maintainer - Usage Manual - 12



Setting Configuration Options

O Printer Maintainer

A4

. 4 Printer Maintainer 1.32
¢

. P

oy g www.FmProMigrator.com

<~%" § This utility runs via a scheduled
job to print a sample page to an
inkjet printer preventing print
heads from drying out.

= 0w O

Print Delay (sec.)

= 0,

Add Printer

6

Default Text:

0

From Computer: <%the hostname%>
Date/Time: <%the long date%>, <%the long time%>

= O 0O

Print Quit

Each of the settings described here will be automatically saved into the preferences file when the
options are selected.
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(1) Print Delay is set by selecting the number of seconds to delay from the pop-up menu displayed
whenever clicking close to the Print Delay button.

Default = 10 seconds

(2) Click the Add Printer button to display the list of available printers configured on this computer.
(3) List of printers - empty by default.

(4) The Default text field shows the text and bands of color (CMYK) which will be printed on the
selected printer.

Additionally, the name of the computer and Date/Time info will be printed.

This field can be modified to add additional info below the Date/Time line of text.

(5) Click the Print button, to immediately print the Default Text to the currently selected printer.

(6) Click the Quit button or select the File -> Quit menu to quit the app.
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Add a Printer

O @ Printer Maintainer

Printer Maintainer 1.32

www.FmProMigrator.com

This utility runs via a scheduled
job to print a sample page to an
inkjet printer preventing print
heads from drying out.

=

10
Print Delay (sec.)
Add Printer
= EPSON XP-630 Series @ dcsi MBP15r2 @
—
Xerox Phaser 6510 DNI @
Default Text:

From Computer: <%the hostname%>
Date/Time: <%the long date%>, <%the long time%>

= O

Print Quit

(1) Click the Add Printer button to add a printer to the list of printers which will be used for printing.
You will be prompted to select a printer from the list of printers, then you will be prompted to select
the Page Setup options for the printer.
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Then the printer and its icon will be added to the list of printers - as shown in this screenshot.
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Delete a Printer

O ® Printer Maintainer

Printer Maintainer 1.32

www.FmProMigrator.com

e A
s,

This utility runs via a scheduled
job to print a sample page to an
inkjet printer preventing print
heads from drying out.

w 10

Print Delay (sec.)

=

Add Printer

. EpSON XP-630 Series @ dcsi MBP15r2  [11]
-
—
Xerox Phaser 6510 DNI 0 @
g  Xerox ColorQube 8700X @
o
Default Text:

From Computer: <%the hostname%>
Date/Time: <%the long date%>, <%the long time%>

= O

Print Quit

(1) Click the red trash can icon at the right side of the row of printer info to delete it from the list.
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Adding Default Text Calculated Values

Default Text:

From Computer: <%the hosthname%>
Date/Time: <%the long date%>, <%the long time%>

The text shown in the Default Text field bracketed between <% %> symbols represents LiveCode
scripting code. The LiveCode development environment dictionary provides the full list of
commands available.

LiveCode is the cross platform development environment used to develop the Printer Maintainer

utility.

More info and free downloads of LiveCode Community Edition are available from:
www.LiveCode.org
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Configuring a Windows
Scheduled Job
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Using the Windows Task Scheduler
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Open Task Scheduler - Windows 7

Programs (1)

() Task Scheduler @

Control Panel (19)

ol Taskbar and Start Menu

[ Perform recommended maintenance tasks automatically
1% View running processes with Task Manager

ol Auto-hide the taskbar

ol Customize the taskbar

ol Group similar windows on the taskbar

,_I_ Lock or unlock the taskbar

. Turn toolbars on the taskbar on or off

Customize icons on the taskbar

Show or hide inactive icons on the taskbar

= Show or hide the notification area on the taskbar
Show or hide volume (speaker) icon on the taskbar

Show or hide battery icon on the taskbar

f0 D ED ED ED fD

Show or hide clock icon on the taskbar
Schedule tasks
:.E View network status and tasks
k. What happened to the Quick Launch toolbar?
Remove icons from notification area (system tray) on the deskt...

[ View list of running gadgets

- See more results

—
| task ‘1’ x| | Shutdown | » |

(1) Click the Start menu, then start typing the application name into the search box.
Before you finish typing the entire word, Windows will show the Task Scheduler in the list of apps.
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(2) Click Task Scheduler in the listto open it.

Open Task Scheduler - Windows 10

All Apps Documents Settings Web More ¥ oy
Best match
Task Scheduler ¥
$ ] s _+__
App ¥ . ./
Apps
Task Scheduler
»~' Task Manager > App
Settings
Tasks privacy settings > =7 Open
Search the web CO  Run as administrator
/O task s - See web results > Il Open file location
<2 Ppin to Start
<= Ppin to taskbar

Click the Start menu, then start typing the text: task scheduler
Before you finish typing the entire word, Windows will show the Task Scheduler in the list of apps.

Click Task Scheduler in the list to open it.
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Create Basic Task...

Task Scheduler

File = Action View Help
e Create Basic Task...

Ta Create Task...

0—@ Import Task...

Display All Running Tasks
Enable All Tasks History

o —

pda.. Ready Multiple triggers defined
pda.. Ready At12:12 PM every day - After triggered, repeat every 1 hour for a duratig

Status Triggers

St.. Ready At 11:00 AM on 5/1/92 - After triggered, repeat every 1.00:00:00 indefinit
New Folder... M... Ready At9:21PM on 12/7/19
d_S.. Ready At12:47PM every day - Trigger expires at 2/14/30 12:47:33 PM.
Refresh
Help >
General Triggers Actions Conditions Settings History (disabled)

Name: GoogleUpdateTaskMachineCore ~

Location:  \

Author:

Description: | Keeps your Google software up to date. If this task is disabled or stopped, your
will not be kept up to date, meaning security vulnerabilities that may arise canr
features may not work. This task uninstalls itself when there is no Google softwi

Security options
When running the task, use the following user account: v
< >

Quickly creates a simple task.

(1) Click the Task Scheduler Library folder.
(2) Select the Action -> Create Basic Task... menu item.

VIILR vapLluic

T TT———

Actions

g

®

i
©

4

$

L

X

R R —

Create Basic Task...

Create Task...

Import Task...

Display All Running Tas...
Enable All Tasks History
New Folder...

View >
Refresh

Help

Selected Item -

Run

End
Disable
Export...
Properties
Delete
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Name the Task

Create Basic Task Wizard X

"®| Ccreate a Basic Task

Create a Basic Task Use this wizard to quickly schedule a common task. For more advanced options or settings
Trigger such as multiple task actions or triggers, use the Create Task command in the Actions pane.
Action Name: |Printer Maintainer Launcher Q |
Finish

Description: | Launch the Printer Maintainer app to print a sample page to the inkjet printer]

©

(1) Enter a name for the scheduled task.
(2) Enter a description for the scheduled task.
(3) Click the Next button.
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Configure Trigger

Create Basic Task Wizard

"®| Task Trigger

[ —

Create a Basic Task When do you want the task to start?

p—
Weekl
Y O ® Weekly

Action
Finish O Monthly

(O Onetime

(O When the computer starts

(O Whenllog on

(O When a specific event is logged

< Back

Next > g: ’\ Cancel

(1) Click the radio button for a Weekly task.
(2) Click the Next button.
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Choose Day of Week

|
| Create Basic Task Wizard

| S —
O] Weekly

Create a Basic Task

Trigger

Recurevery: |1 | weeks on:

Action o

Finish [J Sunday [ Mond&{ ' )[] Tuesday [ ] Wednesday

(] Thursday [] Friday  [] Saturday

< Back

Start: | 2/14/20 (@~ | |12:56:48 PM Q’ [J Synchronize across time zones

Next > g ; >\ Cancel

(1) Choose a day of the week and a (2) time.
(3) Click the Next button.
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Select Action - Start a Program

Create Basic Task Wizard
L —

' Action

]

Create a Basic Task

Trigger What action do you want the task to perform?
Weekly

(® Start a program O

Finish (O Send an e-mail (deprecated)

O Display a message (deprecated)

< Back

| Next > ! ; > ’ Cancel

N

(1) Click the Start a Program option.
(2) Click the Next button.
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Select Application to Start - (1)

|
Create Basic Task Wizard

| Start a Program

[ —

Create a Basic Task

Trigger Program/script:

Weekly

,w i
Brows!

Action

Add arguments optional

Finish Start in (optional):

< Back

Next >

=n

(1) Click Browse button.
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Select Application to Start - (2)

|
Create Basic Task Wizard

Open
|| € v 1 <« Print... » Printer Maintai... »

Organize ¥ New folder

TurboTax A Name

@ OneDrive Externals

I J: Printer Maintainer 1.01.exe
B This PC

) 3D Objects
I Desktop
Documents
& Downloads
ﬁ Music

[&=| Pictures

@ Videos

‘w Local Disk (C:)

T SR N DR v £

v O

Search Printer Maintainer 1.01 0©

= -
Date modified

2/10/20 9:56 AM
QO  009s55am

X

m @

Type

File folde

Applicatig

File name: | Printer Maintainer 1.01.exe

v| | Alfiles ()

Open

Cancel

Cancel

=

(1) Navigate to the location where the Printer Maintainer app was installed, select its EXE file.

(2) Click the Open button.
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Select Application to Start - (3)

Create Basic Task Wizard

"®| StartaProgram

j S—

Create a Basic Task
Trigger

Weekly "C:\ds\Printer Maintainer\Printer Maintainer 1.01\Printer Maintainer 1.(
Action

Add arguments (optional:
Finish

Program/script:

Browse...

Start in (optional):

< Back Next>0{ Cancel ]

(1) Click the Next button.
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Click Finish Button

Create Basic Task Wizard
Summary

Create a Basic Task

Trigger Name:
Weekly Description:
Action

Start a Program

Trigger:

Action:

Printer Maintainer Launcher

printer.

Launch the Printer Maintainer app to print a sample page to the inkjet

Weekly; At 1:21 PM every Monday of every week, starting 2/14/20

Start a program; "C:\ds\Printer Maintainer\Printer Maintainer 1.01\Printer Ma

0 [“] Open the Properties dialog for this task when | click Finish
When you click Finish, the new task will be created and added to your Windows schedule.

< Back

Finish e

Cancel

(1) Click the checkbox next to the Open Properties dialog (2) Click the Finish button.
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Scheduled Job Properties - Run Whether User is Logged On or Not

(® Printer Maintainer Launcher Properties (Local Computer)

General Triggers Actions Conditions Settings History (disabled)

Name: Printer Maintainer Launcher

Location: \

Author: DAVIDSIMPSOAS89\dsimpson

Description: | Launch the Printer Maintainer app to print a sample page to the inkjet printer.

Security options
When running the task, use the following user account:
DAVIDSIMPSOAS89\dsimpson Change User or Group...

O Run only when user is logged on

Q@) Run whether user is logged on or not

[[] Do not store password. The task will only have access to local computer resources.

[] Run with highest privileges

[] Hidden Configure for: | Windows Vista™, Windows Server™ 2008 v

OK z:>{ Cancel

Open the scheduled job you just created. (1) Click on the radio button "Run whether user is logged
on or not", (2) Click the Ok button.
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Configuring a macOS
Scheduled Event
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Using the Scheduler App From: www.macscheduler.net

Downloading Scheduler for Macintosh

Scheduler for Macintosh

Version 7

What's New Downloads Register Contacts

A free all-around scheduling utility for the Mac

Downloads

Scheduler Version 7.3

Current

Legacy -

Date: 16 December 2019

Requires macOS Sierra (10.12) or later

3]

The Scheduler app is available from: hitps://www.macscheduler.net/download.html

This app is available for free, but does require submitting an email for registration to receive a free
license key via email.
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Install Scheduler App

A
F

Applications Scheduler.app

.“

Uninstaller.app

Double-click on the Scheduler.dmg file to open the disk image. Drag the Scheduler.app icon to the
Applications folder you see within the DMG window.

Launch Scheduler.app

! N WA WA IIUPF

5/ ScanSnap Home.app
» | | ScanSnap Online Update
o % Scheduler.app
& Scheduler7.dmg
O Screenium 3.app
K& Screenshot Toolbar 1.01.app

(1) Launch the Scheduler.app by double-clicking its icon within the applications folder.
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Create Scheduled Event

Window
S @ @ E @
Q €0 0@
Group Alert §Application ocument Script Delete Clone Go Stop Sounds Hotkeys Calendars
Due ~ Deferred Calendar

il

BH= -

Click the Application icon in the Scheduler configuration window.
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Scheduled Application Event Window

® Run Printer Maintainer App

O

Title:  Run Printer Maintainer App

Date and time of launch:

Date Time
® B27/2020 | 9:38 PM 4O,
Thursday

\ 4
Application or applet to launch:

Printer Maintainer 1.01.app @ Browse...

Launch options:

) Launch on computer startup

| Launch after minutes of inactivity: = 15 minutes

@ © Launch on date and time

¥V Options:

@ Repeat: Every Thursday
Snooze for: >
Activate between: ~ and 5

Cancel O oK

(1) Enter a title for the scheduled event, (2) choose a date and (3) time for the first time the Printer
Maintainer app should run, (4) Browse to select the Printer Maintainer app, (5) select the Launch

on date and time radio button. (6) Click the Repeat checkbox, then select todays day of the week
from the Repeat menu.

If more flexibility is needed for scheduling, then the Custom... menu option can be selected, which
will open another configuration window with more details.
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When setting a day of the week/time for running the Printer Maintainer, you may want to configure
the app to run when users won't generally be using the computer. The computer needs to be
turned on, butif a user is performing other tasks they could be surprised to see the app open on its
own. Printer Maintainer will quit when it has completed printing. But if the user clicks anywhere on
the Printer Maintainer window, it will pause the countdown timer indefinitely.

(7) Click the Ok button to save the changes.

Application Event in List

@® @ Window

L9 Z}\ @ 6 y ¢ & @

Group Alert Application Document Script Delete Clone Go Stop
Active Name Due A Deferred

/A Run Printer Maintai... today, 9:38 PM

— ooo Qv
= ooo

@ m

Sounds Hotkeys Calendars

Calendar

None @

(1) click the Deferred checkbox so thatitis unchecked, (2) select None from the Calendar menu.
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Registering the Scheduler App

0

Search

Scheduler Help

What's New

Scheduler's Web Site

Is this the latest version?
End User License Agreement

Select (2) Register Scheduler from the (1) Help menu to register the app for free on the computer
where itis being used.
The website will open with a registration form.
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Registration Form

A free all-around scheduling utility for the Mac

Registration

Register Scheduler Registration form
to ensure that
public versions of
the software will be - Although Scheduler for Macintosh is freeware, registration is

. mandatory after a 30-day trial period. Fill in this registration form and
available to you for submit it to receive an email message containing a free registration
free and to let us code. This registration allows us to measure our installed base and
know that there is verify whether new public releases of the software are worthwhile.
interest in it.

Version you wish to register: o
Name: — 9‘
Email: = 9
Email: ‘e‘

6 | | want to be warned when a new release of the software comes out.

(CsuBMiT = @

(1) Select the version you want to register, (2, 3, 4) enter your name/email info, (5) select the
notification checkbox if you want to be notified of updates, (6) click the Submit button.
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Updates
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Checking for Updates...
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Checking for Updates...

32 File Edit @gEls
0@ A Search
Help

. Check for updates... o

www.FmProMigrator.com

@ This utility runs via a scheduled
job to print a sample page to an
inkjet printer preventing print
heads from drying out.

Print Delay (sec.)

B

Add Printer

EI’J Xerox ColorQube 8700X @

Xerox Phaser 6510 DNI @

qﬁ EPSON XP-630 Series @ dsi MBP15r2  [11]

Default Text:
C

e
= o

Print Quit

Select the Help -> Check for updates... menu to download the latest version of the Printer
Maintainer utility. Follow the installation instructions earlier in this manual. The preferences will be
preserved when updating to a new version of the app.
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Troubleshooting
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Troubleshooting

Printer Driver Name Issue - macOS

Default
Name ~ Kind
DYMU Labelwriter 45U 1urno @ MBP1/U Bonjour snared
Xerox Phaser 6510 (6d:15:75) Bonjour

| to Mac @ MBP17U Bonjour
DYNIO LabelWriter 450 Turbo 2 @ dcsi MBP16 Bonjour
(2] DYNIO LabelWriter 450 Turbo @ MBP17 @ dcsi MBP16 Bonjour
2] DYNJO LabelWriter 450 Turbo @ MBP17U Bonjour
EPSDN XP-630 USB @ MBP17U Bonjour
[2] Xer@x ColorQube 8700X @ dcsi MBP16 Bonjour
(2] Xer@x Phaser 6510 DNI @ dcsi MBP16 Bonjour
[2] Xer@x Phaser 6510 DNI @ MBP17U Bonjour

Name: ([ EJSON XP-630 USB @ MBP17U

Location: Printopia @ MBP17U

<

Use: AirPrint

Add

Sometimes unusual characters will appear at the left side of the name of the printer driver, when
adding a new printer. Notice how some of the drivers have the question mark symbol in a box and
a space before the actual driver name.

These 2 characters should be removed from the name when adding the printer in System
Preferences -> .Printers & Scanners.

Otherwise, Printer Maintainer might not be able to add the printer properly to the list of printers.
The printer may show up with a blank icon and a blank name as itis displayed in the list of
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printers.

If this happens, just delete the printer from the list of printers in Printer Maintainer.
Delete the printer from the list of printers in System Preferences and add it again after editing the
printer name to remove the leading question mark and space characters.
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